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AFTERBEFORE

 The Next Evolution of Editing with Transcripts

This manual is BETA. It is not fully complete.
However, the What’s New section contains info about new features. Most things 
work as they did in 2.0, so most info is relevent. But the new features have not 
been added to the main body of the manual yet. Thanks for your patience.

Please check out digitalanarchy.com for additional tutorials on new and old 
features.
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Keyboard Shortcuts

Keyboard Shortcuts are a huge part of Transcriptive and can make working in it much 
faster/easier. These are for Transcriptive 2.x/3.x. If you’re still using 1.x, please check the 
manual.

 
Ctrl + Space: Play / Stop

 
Undo: Ctrl + Z (Mac and PC)

Redo: Ctrl + Shift + Z

MAC USERS: Mac OS assigns Cmd+Z to the application (Premiere) and we can’t change that.

 
Editing text:

Ctrl + Left Arrow – Previous Word  |  Ctrl + Right Arrow – Next Word

 
Merging/Splitting Lines/Paragraphs:

Ctrl + Shift + Up OR [Delete]: Merge Line/paragraph with line above.

Ctrl + Shift + Down OR [Enter}: Split Line/paragraph into two lines.

(These behave slightly differently. ‘Control+Shift+up’ will merge the two lines together no matter 
where the cursor is. If you’re trying to combine a bunch of lines together, this is very fast. [Delete] 
uses the cursor position, which has to be at the beginning of the line to merge the lines together.)

 
Up or Down Arrow: Change Capitalization

 
Ctrl + Backspace: Delete Word | Ctrl + Delete: Delete Word

 
Ctrl + Up: Previous Speaker | Ctrl + Down: Next Speaker

Editing Video (Clip Mode only):

Control + i: Set In Point in Source panel

Control + o: Set Out Point in Source panel

Control + 8 and Control + , (comma): Insert video segment into active sequence (this does the same 
thing as , (comma) in the Source panel. Control + , works on PC but there’s a Premiere bug on Mac 
that causes it to sometimes work and sometimes not. Use Control + 8 on Mac.)
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About This Manual

While the manual is a good resource, we recommend checking out the videos on Transcriptive to 
really get an understanding of how it works. Often it’s easier to show something than to try to explain it 
with words, especially with something that’s visual to begin with.

However, it can be hard to go into lots of detail in a video, so this manual usually provides more info 
than you’ll find in the tutorial videos. The videos and manual are designed to complement each other.

Here are the tutorial videos, they’re all aournd 5 minutes or so:

Transcriptive Rough Cutter Tutorials: 
https://digitalanarchy.com/transcribe-video/premiere/tutes.html

Transcriptive Web App Tutorials: 
https://digitalanarchy.com/transcribe-video/app/tutes.html

PowerSearch Tutorials 
https://digitalanarchy.com/premiere-search/tutes.html

PowerSearch is included with your purchase and your serial number will activate it. However, 
it’s a separate download. You can get it by going to our Demo pages.

https://digitalanarchy.com/demos/psd_win.html#d12 (Windows)

https://digitalanarchy.com/demos/psd_mac.html#d12 (Mac)
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Installation

You can always download the most up-to-date version of Transcriptive from our Demo page. Your serial number will activate 
the demo.

Mac Demo:

https://digitalanarchy.com/demos/psd_mac.html#d11

Download the .dmg file and run the Installer that’s on the dmg.

This will install the Transcriptive panel and associated files into: 
Macintosh HD/Library/Application Support/Adobe/CEP/

It will also install the FLAC exporter into: 
Macintosh HD/Library/Application Support/Adobe/Common/Plugins/7.0/MediaCore/Digital Anarchy

Once the installer finishes, it’ll bring up the Digital Anarchy Registration page. Please fill out the registration and close 
the installer.

Restart Premiere Pro and Transcriptive should show up in Premiere under Windows>Extensions>Transcriptive 

If at some point you wish to uninstall Transcriptive completely (this is sometimes helpful in troubleshooting problems with a new 
version), run the Un-Installer. 

Windows Demo:

https://digitalanarchy.com/demos/psd_win.html#d11

Open the .zip file and launch the Transcriptve_Installer.exe. If you are updating or upgrading, you’ll be asked if you 
want to uninstall Transcriptive. Click OK to run the un-installer. (highly recommended)

Click through the installer, agreeing to the license terms. The installer will automatically select the correct directory, 
don’t change this unless you have an unusual system and you know where the panel should go.

This will install the Transcriptive panel, Premiere Power Search panel and associated files into: 
C:\Program Files\Adobe\Adobe Premiere Pro CC 2017\CEP\extensions

It will also install the FLAC exporter into: 
C:\Program Files\Adobe\Common\Plug-ins\7.0\MediaCore\Digital Anarchy

Once the installer finishes, it’ll bring up the Digital Anarchy Registration page. Please fill out the registration and close 
the installer.

Restart Premiere Pro and Transcriptive should show up in Premiere under Windows>Extensions>Transcriptive

If at some point you wish to uninstall Transcriptive completely (this is sometimes helpful in troubleshooting problems with a new 
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Licensing and Activating Transcriptive Rough Cutter

Licensing Transcriptive is significantly different than it was previously.

You can register the panel with your serial number or by logging in with your Transcriptive.com 
account. If you log in with your Transcriptive.com account, once you link a serial number to it, you 
don’t need to remember the number. Just log in and you’re good to go.

You can also deactivate other computers or manage all your licenses in one place.

Of course, if you have any problems with licensing, please email us at cs@digitalanarchy.com or call 
1-415-287-6069. Phone support is: 10a-5p PST, Mon-Fri. Email support is seven days a week.

Some problems can be solved by deleting the license file. This is located at:

Windows: C:\Users\Public\Documents\Digital Anarchy\Receipts
Mac: Main Hardrive\Users\Shared\Digital Anarchy\Receipts

Trial Licenses

If you’re just trying out Transcriptive Rough Cutter, you’ll need to register to get a trial account. Just 
click on the ‘Get Trial License’ button that you see in the License dialog.

This will give you a free trial with 30 minutes of free transcription. There are some limits, mainly that 
you can transcribe a maximum of two minutes at a time. If you’d like an unrestricted trial please email 
sales@digitalanarchy.com. We’re happy to give you a week long trial with no limitations.



11 © 2021, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: Install & Requirements

Activating A Purchased License

When you launch Transcriptive for the first time, you’ll see the same dialog above. 

To license the plugin, you can either: 

1) Enter the credentials for your Transcriptive.com account 
2) Click on the ‘Click here to register with just your serial number’ link… this will let you enter your 
serial number and be on your way.

There are some advantages to #1. If you enter your Transcriptive.com credentials, you’ll need to link 
your serial number to your account. You only need to do this once. After that you can log in anywhere 
and your license will follow you. It also makes it simple to re-license the plugin if it becomes un-
licensed for any reason. (usually because it’s been inactive for more than 30 days)

Just using your serial number is a bit faster initially, but in the long run, just logging into your account 
and not having to always find the serial number could be easier. 

Deactivating

The easist way to do this, is to log out if you’ve licensed it by logging into your Transcriptive.com 
account. That will immediately unlicense the plugin.

You’re allowed to install Transcriptive Rough Cutter on two computers. If you go over that and try to 
use a third computer, you’ll get a message saying you’ve logged into to too many computer and will 
need to deactivate them.

Just select ‘Deactivate all other machines’ and you’ll be able to log in.

It’s worth noting that you can INSTALL on two computer, but you can use them simultaneously (i.e. two 
people at two different computers). It’s really designed for one user with, say, a laptop and desktop 
machine, where the machines won’t be in use at the same time.
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Setting Up Your Transcription Account

You must set up an account on Transcriptive.com in order to transcribe. It’s free but you need to enter 
in a credit card to cover the transcription costs ($0.04-0.08/min).

Just go to https://app.transcriptive.com and you’ll see this screen:

Select ‘create a New Transcriptive Account’ and enter in your information. If you just intend to use 
the  Premiere panel, select the ‘Transcribe Only’ free account. You can also select the ‘Review Only’ 
account, but this will not ask you for a credit card. Once you go through your 30 free minutes of 
transcription, you’ll be unable to transcribe until you enter a credit card. So ‘Transcribe Only’ is best.

Once that’s created, you’ll be able to enter your credentials in the Premiere panel and you’ll be good 
to go to transcribe!

To enter the credentials in the Premiere panel, go to the Account dropdown in the upper, right corner. 
Just click the Login button and put in your account info.
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Common Problems 

Slow Performance

There can be a lot of reasons for this but a couple of the main ones are 1) really long transcripts and 
2) Adobe’s NewWorld javascript engine.

Really Long Transcripts: On the surface, the transcripts just look like text. However, in Transcriptive, 
ever word has timecode and a bunch of other metadata attached to it. A two or three hour transcript 
can bog Premiere down. Especially if there are lot of individual sentences. Sometimes this is 
unavoidable (i.e. different speakers), but sometimes the A.I. will put each sentence on a different line 
for no good reason.

When you transcribe, you should have ‘Combine lines into paragraphs’ checked. This will group 
sentences spoken by the same speaker into paragraphs. Much more memory efficient, resulting in 
better performance.

Adobe’s New World: Adobe added a new javascript engine to Premiere in 2019. This is supposedly 
better than the old engine, but New World is buggy in some instances and Adobe seems to be in no 
hurry to fix it. Kind of frustrating for everyone.

The big issue is that it can cause slow downs when switching betwen clips. So if you’re trying to use 
Transcriptive to create Selects and switching between lots of clips, there can be a significant delay 
loading the new clip. Not a big deal for one clip but it gets really annoying if you’re rapidly trying to 
view a bunch of clips.

You can turn New World off... This will speed things up considerably. The downside is that some of 
Premiere’s built-in panels don’t work with it off.  So if you turn it off, the Premiere Home Screen won’t 
show up (the splash screen that appears when you launch PPro that shows your recent projects). Also 
some newer panels, like the Text panel, don’t work. Most things work fine with it off, but keep an eye 
open for panels that don’t open. You can turn it off by going to Transcriptive Main Menu>Preferences 
and clicking the New World button. You can turn it On or Off, but after doing so, you’ll need to restart 
Premiere.

Entering a Credit Card

If you’ve create a Trial Account or a Review Only account, you may not have been asked for a credit 
card. Not a problem if you haven’t used your free minutes, but after those run out, you’ll need to add 
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a credit card to your account in order to transcribe anything. 

To do so, go to the Account menu in the Premiere panel and click ‘My Dashboard’.

This will take you to Transcriptive.com, where you’ll need to login. Then go to Settings and select 
‘Card’. You can then enter in any Visa, MasterCard, Amex, or Discovery card number. You’ll be all set 
and can start transcribing!
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What’s New in Transcriptive Rough Cutter

Transcriptive Rough Cutter : The next evolution of text based video editing

Technically this is Transcriptive 3.0 but we’re moving away from the emphasis on transcrip-
tion and focusing on the features that enable you to use the transcripts as part of your editing 
workflow. There are a lot of great new features and improvements to help you make the most 
of transcripts, no matter where you get them from. As such, we’re renaming it to Transcriptive 
Rough Cutter. 

New Features

There are essential five big changes/improvements:

Rough Cut & Selects: Rough Cut will take an edited transcript and create a sequence with 
edits where deleted or struckthrough text is. It’s a great way to quickly assemble a starting 
sequence. The Selects workflow lets you use PowerSearch and the ability to set In/Out points 
in a transcript to easily find soundbites and insert them into a sequence.  
Batch Transcribing: Batch Project is much easier to use and intuitive and Alignment can now 
be batched.
Alignment: As mentioned you can now do Batch Alignments, but the Alignment feature has 
been improved and even more critical now that you get transcripts from so many services, 
including Adobe’s new service. 
Sharing: This is now easier to use and, hopefully, more intuitive. It’s mostly cosmetic changes 
but there have been small improvements to some things in the panel, as well as the web ver-
sion of Transcriptive at https://app.transcriptive.com.
Integration: A lot of the reason for the above changes was to tie the features together better. 
We’ve been slowly adding features over the last two years and Transcriptive Rough Cutter is 
what we’ve been aiming for. It’s not just the features, it’s how they integrate. The Rough Cut fea-
ture was the big missing piece and with that, a lot of the other features become more powerful. 

For example:

- You can use alignment to sync imported transcripts (from Adobe, Rev, etc) to your audio
- Use Clip Mode to set In/Out points and drop Selects into your master timeline
- Send the transcript created from those Selects to a Producer for additional edits or they can 
add comments
- They can send that back to you and you can create a rough cut based on their deletions or 
comments.
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Rough Cut

Rough Cut allows you to edit a transcript, either in Premiere or on Transcriptive.com, and have 
Transcriptive create an edited sequence in Premiere. The edits in the sequence will match the 
edits in the transcript, creating an instant rough cut or assembly. 

This is at the heart of Transcriptive Rough Cutter and the big change from Transcriptive 2.0.

It’s also different than the Transcriptive Selects workflow, which is explained on the next page.

Clip or Sequence?

The edited transcript can come from either a clip or a sequence with a single or multiple clips. 

The process is:

- You transcribe the clip or sequence
- You then edit the transcript in Premiere or send it to a colleague to edit in Premiere or on 
Transcriptive.com. We recommend removing lines with the new Strikethrough feature (see 
below)
- If you send it to a colleague, they can send it back to you once they’re done.
- No matter where you edit it or who edits it, you never lose the timecode associated with 
each word, the speakers, or the ability to search and play it back. It behaves the same as any 
other transcript in Transcriptive.
- Once the transcript is edited, click the Rough Cut button and Transcriptive will assemble a 
rough cut from the transcript.

There are some limits to the Rough Cut feature. You can only delete/strikethrough text and 
add comments, you can’t rearrange the text blocks (basically a limit of the Premiere panel 
API). Once the rough cut sequence is created, you can rearrange things in your timeline. To 
sync the transcript to the re-arranged timeline, select Main Menu > Sync Transcript to Se-
quence Edit. This will re-generate the transcript based on your edits.

Also, if you have a very complex sequence, it may fail. It works most reliably on sequences 
that only have the video/audio of the original footage. Don’t add sound effects, b-roll, titles, 
color correction, etc. Rough Cut may or may not manage all those elements correctly when 
the new sequence is assembled.
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Editing/Correcting The Text

If you clean up the transcript while you’re striking-through text for the rough cut, you’ll need to 
Export>Speech Analysis before clicking the Rough Cut button. That will save the changes to 
the text you’ve made. If you don’t do this, the rough cut will use the original transcript, not the 
cleaned up one. 

Generally we recommend cleaning up the transcript at the end. The A.I. services are very ac-
curate, but they aren’t perfect. So some clean-up is usually needed. But instead of cleaning 
up the entire transcript, wait until you’re reasonably sure what you’re going to use and what 
you’re going to throw away. It’ll cut down on the cleanup time.

Transcriptive Selects: Creating A Rough Cut with Selects

This is another method of creating a rough cut or assembly.

In Clip Mode you can set In/Out points (Control + i / o) and insert (control + 8 or control + ,) 
them to a master sequence. Starting the assembly process by grabbing soundbites from many 
different clips. The text between the In/Out points will be highlighted, this is a new feature and 
makes it much easier to see what’s selected.

We’ve also improved how setting in/out points work. The green and red arrows should now 
always stay visible. But the highlight is the big improvement.

You can then rearrange them in your sequence timeline and re-generate the transcript in 
Transcriptive by going to Main Menu > Sync Transcript to Sequence Edit. The newly created 
transcript will reflect the new timeline. Unfortunately, due to limitations in Premiere we can’t do 
this automatically. We don’t know what’s going on in the timeline until you tell us to check.

Of course, with the Rough Cut feature you can assemble things and send it to someone else to 
make additional edits.

Strikethrough     
 

What if you want to delete something from the transcript for the rough cut, but you still want 
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Original

Beauty Box

that text to show up in the original clip or sequence? Use Strikethrough!

By using Strikethrough you can still see the entire transcript. This is important because the 
original, uncut footage should have a pristine transcript attached to it. If you permanently 
delete parts of the transcript, it no longer matches the dialog of the uncut footage. So if you’re 
creating a trailer and permanently delete some of the transcript, you’ll need to re-transcribe 
when you use the same footage for the movie.

One other huge advantage for Strikethrough is that the text is still searchable. In the screen-
shot above, if I do a search for ‘million’, you’ll still be able to find it if you use Strikethrough. If 
that line just gets deleted, it’s gone and won’t be searched. So Strikethrough allows you to still 
find something even if you accidentally struck out the wrong line/take/etc. Or the director 
suddenly goes “Why aren’t we using that other take? I loved that other take!”

To Strikethrough a line, just click on the S icon at the far right of the Transcriptive UI. You can 
only Strikethrough entire lines, not individual words. If you want to just Strikethrough a few 
words, you’ll need to split (Cmd/Alt+Shift+Down Arrow) the line/paragraph so the few 
words are on their own line.

Sharing

We’re making the process of sharing transcripts and video more intuitive and easy. Mostly 
what is changing is the UI and some behind the scenes stuff. The Transcriptive Web App 
(Transcriptive.com) gives you a powerful way of sharing the transcript/video for review or to 
have someone else edit it. 

The ability to have someone else correct the transcript, delete or strikethrough words or para-
graphs, and add comments is a critical piece of Transcriptive Rough Cutter. So we wanted to 
make that more intuitive and easier to use than it currently is. It works fine as it is, but we’ve 
heard from users that it’s confusing and there’s a steeper learning curve than there should be. 
Hopefully that will be much improved in this version.

The Transcriptive Web App is really meant to be a complement to the Premiere panel. As 
a standalone website, we realize it’s a bit lackluster. But when combined with the Premiere 
panel, it’s a pretty powerful way of collaborating!

We designed Transcriptive Web assuming anyone using it would be collaborating with some-
one using the Premiere panel. It was important to us that the UI be more or less than same 
and, most importantly, that sharing transcript data was completely lossless when going back 
and forth between Premiere and Transcriptive.com. This is what allows you to make edits on 
the web, create rough cuts in Premiere and constantly go back and forth.
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For an in-depth demonstration, we recommend watching this tutorial video: 
https://youtu.be/CHkkdawxYuo

Batch Transcription Improvements - Including Alignment

Batch processing is getting a big upgrade! There are three important changes:

Batch Project: You can now select any clip or sequence in the Project panel to be batch tran-
scribed! Currently everything has to be in a Transcriptive bin (see above image). That require-
ment is now removed and you can just Shift + Click media,  sequences or entire bins in the 
Project panel. You no longer have to re-arrange your Project panel just to batch transcribe a 
large number of items. Just Shift+Click to select multiple items or Bins and select Batch Project 
from the Transcriptive menu!

It’s a much more intuitive way of batch transcribing.

Parallel Processing: Multiple files will be submitted at the same time. This makes batch pro-
cessing much faster. Currently we do them one by one which creates a bottleneck and can tie 
up Transcriptive for quite a while. This should speed the process up significantly.

Batch Alignment: You can now use Batch Project to batch align clips or sequences that 
have imported transcripts and need to be aligned. This is a big deal, as alignment takes 2-4x 
longer than regular transcribing. You no longer have to wait around for one to finish before 
starting the next one. The clips/sequences need to have the transcript imported first. So 
there is some setup involved. But once that’s done, just use Batch Project to align all of them! 
More details below...

Alignment

Before you can Batch Project for alignment, all the clips and sequences need to be set up 
properly. You must import an existing transcript, usually a plain text or SRT file, for EACH clip 
or sequence. Once this is done for every one that you want to Align, you can select the clips/
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sequences in your Project panel and select Batch Project.

Alignment only works with Batch Project due to the requirement of manually connecting the 
existing transcript to the video. You have to set that up in Premiere and Batch Files and Batch 
Folders look outside of Premiere. So Batch Project is what you need to use. For an in-depth 
demonstration of this, please check out this tutorial video: https://youtu.be/SaRpvJY77zw

Before you can Batch for alignment, all the clips and sequences need to be set up properly. 
You must import an existing transcript, usually a plain text or SRT file, for EACH clip or se-
quence. Once this is done for every one that you want to Align, you can select the clips/
sequences in your Project panel and select Batch Project.
Alignment only works with Batch Project due to the requirement of manually connecting the 
existing transcript to the video. You have to set that up in Premiere and Batch Files and Batch 
Folders look outside of Premiere. So Batch Project is what you need to use.

Once Batch Project has confirmed each video has a transcript, you’ll then get the Transcribe 
dialog. Change ‘Transcribe With’ to Alignment. This uses the free, offline alignment. However, 
this only works for English. For other languages, you can select Speechmatics and click the 
Align checkbox. There is a .04/min cost for this service.

PowerSearch Improvements

PowerSearch has been included free with Transcriptive since v2.0. Your serial number will activate it 
and you can download it from our Demos page. It’s currently in beta, but we’re pretty close to releas-
ing it. Definitely download it and check it out.

We significantly rewrote it to make it faster and more efficient at handling large numbers of results. It’ll 
basically search all your transcripts as well as any markers in your project. If you’re hunting around for 
where something was said, PowerSearch is a real lifesaver. 
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Still blotchy, needs more smoothing.

What is PowerSearch?

PowerSearch aims to be Google for your Premiere project. A search engine that can find anything. 
We index everything in your project (this can take a several minutes when you first launch 
PowerSearch) and that allows us to easily search any metadata attached to your clips, markers in 
sequences or transcripts in Transcriptive.

It’ll save you hours of time looking for things. You no longer have to scrub through footage looking 
for the clip where “that guy, said that thing about the Anarchist”. Do a search for “Anarchist” and 
everywhere that shows up in clips, sequences or markers will get displayed to you like search results in 
any search engine. Click on a search result and open that clip or sequence right to where the search 
term was said. It’s pretty amazing.

Detailed info about it is towards the end of this manual, after the Transcriptive content.

Performance improvements with long transcripts

Sometimes the speech services will return transcripts with a lot of individual sentences. Usually 
this isn’t a problem, but when a video/sequence is two, three or more hours long, all those 
sentences take up a lot of memory. This slows Transcriptive down when dealing with very long 
transcripts. It’s particularly a problem with the way Speechmatics gives us back results. This 
can happen with Transcriptive-A.I. as well, but it’s a more common problem with Speechmat-
ics.

We now do a better job of combining those sentences into paragraphs. If you’re using 
Speechmatics for very long transcripts, you should see a very noticeable performance in-
crease. 

Better Support for Productions & Multicam

Adobe added the Productions feature in 2020. We’ve fixed a number of bugs related to 
Productions, so Transcriptive should work much better with it. We’ve also improved Multicam 
support.

Preference to turn off auto-caps/punc when splitting line (for captions)

This new preference is ideal for massaging a transcript for use as captions. Usually when you 
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split a line Transcriptive adds a period to the end of one line and capitalizes the word at the 
start of the new line. If you’re doing this for captions, that’s not what you want. This new pref-
erence let’s you turn that off.

Duplicate transcript prevention

A lot of new users don’t realize that there’s a delay in transcribing. They submit the same file 
multiple times as a result. We have a new system on the backend that identifies these dupli-
cates and prevents them from going through. That way you don’t pay twice for same tran-
script!

This is also useful in case of an internet hiccup or failure where you don’t get the transcript 
back.

That’s mostly it for new features. There are, of course, many other bug fixes and little 
tweaks as well. It’s a pretty big upgrade from 2.0.
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What is Transcriptive?

Transcriptive is a new way of automatically transcribing video and audio. Making it simple 
to search the video, create subtitles, closed captions, and more. We allow you to use 
two different Artificial Intelligence/Machine Learning services to achieve unprecedented 
automatic accuracy. Why two? It makes it more cost effective as you can choose the 
appropriate algorithm for the quality of your audio. The two differ in cost and accuracy… see 
the How It Works section for complete details. (Transcriptive-A.I. is the more accurate service 
but costs a bit more)

Once the  transcript is processed it then becomes available in Premiere to be edited, 
searched, saved out to markers, or exported as a caption file. You can search the text either 
in the Transcriptive window or Premiere’s metadata panel, making it easier than ever to find 
where something was said in your video. 

You can also import an existing script or transcript and sync that to the audio! Transcriptive 
will add time code to every word, allowing you to easily search the text and jump to the 
corresponding place on the Premiere timeline. This is now free for English and can be 
done offline! See the section on Alignment.

Exported files can be taken into any other application or used in Premiere Pro. Common uses 
are for closed captions, sub-titles, and SEO for YouTube.

How it works? 

Transcriptive will transcribe any clip selected in the Project panel, the active sequence, or you 
can batch process multiple clips. You select what you want to transcribe, set in and out points 
if necessary, and open the Transcriptive panel and click TRANSCRIBE.

If you’re batch processing, select the appropriate Batch command from the Main Menu and 
select your files.

You’ll then be asked what Speech Engine you want to use, Transcriptive-A.I. or Transcriptive-
Speechmatics. (see the Speech Engine Setup section for more details on using Speechmatics)

You’ll need to sign up for a Transcriptive.com account and enter your credentials into 
Transcriptive. This will let you use either speech service.

Why do we make you do this?

It’s for your benefit actually. It allows you to select the service that meets your needs. The 
accuracy and cost of the two services differ. Transcriptive-A.I. is more accurate but costs 
more. Speechmatics is good but less accurate (especially with punctuation) and costs a bit 
less. For very well recorded audio, there’s not a lot of difference between the two. For audio 
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that’s lower quality (background noise, accents, poor enunciation), Transcriptive-A.I. is better.

What are the costs?*

As of this writing (December 2019), the costs were as follows:

Transcriptive A.I. : $0.12/min 

Transcriptive-Speechmatics: $0.06/min. One change with Transcriptive 2.0 is that all 
transcribing goes through your Transcriptive.com account. This means you’ll be charged in 
dollars for both services (Speechmatics used to be in Pounds).

Speechmatics: Until January 1, 2020, you’ll be able to use Speechmatics with a 
Speechmatics account. After that you’ll only be able to use it through your Transcriptive 
account. If you have a lot of Speechmatics minutes please contact us to transition them. You 
won’t be able to use them after Dec. 31, 2019.

Transcriptive Human: $1.50/min (via Transcriptive.com, not available in the Premiere panel)

* The Digital Anarchy website will also show the most up to date pricing. (we try to keep the 
manuals up-to-date but it doesn’t always happen)

Which Speech Algorithm Should I Use?

If your audio is poorly recorded, there’s a lot of background noise or heavy accents, you may 
want to consider using the Transcriptive-Human service. A.I. has it’s limits and the poorer the 
recording the worse it’s going to do. 

As for the AI services, Transcriptive-A.I. will usually be the most accurate, especially if you 
consider punctuation which Speechmatics currently doesn’t do. We’re constantly testing an 
array of speech-to-text services and will use whichever is currently best based on the settings 
you choose. The service we use may change based on several factors including whether 
Speaker Identification is turned on or what language you choose. This is a pay-as-you-go 
service, so you just pay for the minutes as you use them. So it’s a pretty easy option.

Speechmatics will also give you very good results. It has about 96% accuracy on clean 
audio. It also doesn’t do punctuation other than periods. It’s less expensive than the 
Transcriptive-A.I.

If you have a lot of background noise or accents, Transcriptive-A.I. is probably your best 
bet. It’s almost always going to be the most accurate with that type of audio. Speechmatics is 
great for clean audio but the accuracy falls off more steeply as the audio quality gets worse.
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If you’re just using the speech-to-text to allow you to search your video and jump to where 
the text is spoken, Speechmatics is a good choice. Yes, it’s somewhat less accurate but if 
you’re just trying to search a lot of video it’s a good option as it’s a bit cheaper than the 
Transcriptive-A.I.

If you’re creating captions and you need 100% accuracy, the less accurate the A.I. is, the 
longer it’ll take you to clean things up. So Transcriptive-A.I. or even Transcriptive-Human is 
probably what will work best.

Of course, we strongly suggest you run a few tests on your own video footage with 
varying audio quality to see the results yourself. We’ve found the above to hold true for the 
vast majority of tests we’ve run. However, your tests, with your audio, will tell you which 
service is best for you as there are plenty of exceptions. For example, Speechmatics will often 
handle accents a bit better than Transcriptive A.I. as much of their training data comes from 
the UK and EU.

System Requirements

Transcriptive requires an internet connection. The only way around this is to use a different 
computer to upload the audio file and get the transcript. You can then move the resulting 
transcript file to the original computer and import it into Transcriptive. It’s easy but is a bit more 
work. (see Importing JSON Files for more info)

You can also import a text file (e.g. human created transcript) and use the Alignment feature 
to sync the text and your audio up. For English, Alignment works offline and is free. So that’s 
workaround for the internet requirement. 

You MUST sign up for a free account on Transcriptive.com and enter in your credit card. You 
can then enter your credentials in the panel and that will allow you to transcribe. Your credit 
card is only used for charging you for the transcription minutes you use.

Premiere Pro 2019 or later. To address some bugs with Premiere we had to require 2019 
for 2.0. We always support the most recent version of Creative Cloud, so Transcriptive should 
work whenever a new version is released.

Transcription Basics and User Interface

Launching Transcriptive

You can launch Transcriptive by going to:
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Window>Extensions>Transcriptive

This will open the Transcriptive panel. Feel free to dock the panel anywhere in the Premiere Pro 
workspace. You can also leave it as a floating window.

First Thing...

The first thing you’ll need to do is to enter in your Transcriptive.com credentials so you can 
transcribe. You can access both Transcriptive-A.I. and Speechmatics with this single account. 
Just go to Transcriptive.com to set up an account and then you can enter that into the panel, 
like so:

Signing Up with Transcriptive A.I.

Transcriptive A.I. : You’ll need to create an account on Transcriptive.com. Go to the Account 
menu in the Transcriptive Panel and click Register. This will take you to App.Transcriptive.com 
where you can set up an account and enter in a credit card number. 
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       Transcriptive Panel      App.Transcriptive.com

After creating the account, go back to the Premiere panel and login. You should know 
see Transcriptive and Speechmatics as an option in the ‘Transcribe With’ dropdown in the 
Transcribe dialog.

You should be all set! Go forth and transcribe!

Can I use YouTube or Facebook to get free transcription?

Yes. This blog post explains how to do both. YouTube is easy, Facebook... not so much:

https://digitalanarchy.com/blog/art-technology/downloading-the-captions-facebook-or-
youtube-creates/ 

If you have a Google Pixel phone, the new Recorder app they released with the Pixel 4 has 
built-in transcription that’s really excellent. Just import the text and audio file into Transcriptive 
and use the Alignment feature!

Speech Engine Setup

This dialog is no longer as important as it used to be.

Main Menu: This is your control panel of 
sorts. Speech Engine Setup and Preferences 
are located here. You can Batch Process files 
using the three options. You can also manage 
transcripts here.
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For Transcriptive A.I. and Speechmatics, all you need to do is log into your Transcriptive.com 
account. Nothing else is needed. You can do this in this dialog or under the Account menu.

For Speechmatics, this is only relevent if you’re using their On-Premise solution. You can enter 
in your credential information by going to the Speechmatics tab in Speech Engine Setup. 

On January 1st, 2020 this will stop working with Speechmatics.com accounts.

If you want to set up Speechmatics on your own in-house server, please contact  
sales@digitalanarchy.com for more information on their On-Premise solution.

Critical Things to Know

Clicking on The Transcriptive Panel

In order for Transcriptive to work, you have to click on the Transcriptive panel. If you just 
select your sequence and hit play, Transcriptive won’t do anything. This is a limitation of 
Premiere. You have to select the Transcriptive panel and hit play from within Transcriptive 
otherwise Transcriptive won’t have any idea what Premiere is doing. Transcriptive is 
technically a separate app running within Premiere. It will communicate with Premiere but not 
vice versa. So control Premiere from within Transcriptive, it won’t work otherwise.

Clip Mode vs Sequence Mode: 

Please review the section on Clip Mode and Sequence Mode. It’s central to how the panel 
works. In Clip Mode, you are editing the transcripts for individual clips that you select in 
the Project panel. This is your Master Transcript. If you turn Clip Mode off, you’re now in 
Sequence Mode. This will show the transcript for the active sequence. Editing this only affects 
the transcript for that sequence. It does not get saved to the individual clips. Again, see the 
section on Clip vs. Sequence Mode and how the transcript data is saved.

Accuracy: 

Both Transcriptive A.I. and Speechmatics are very accurate. However, background noise 
and unclear speaking can make it harder for the speech services to figure out what’s being 
said. The less noise you have and the better your talent enunciates words, the higher the 
accuracy will be. Make sure your talent is mic’d, speaks clearly and any background 
noise is minimized. Talent that has a heavy accent or is off mic will get transcribed with less 
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accuracy (sometimes significantly less) than talent that is mic’d and well spoken. Regardless, 
Transcriptive A.I. is usually the better Speech Service, especially with recordings that have a 
lot of background noise. However, we definitely recommend doing some tests with your own 
audio.

Undo/Redo (especially Mac folks):

You can also use Control+Z for Undo and Control+Shift+Z for Redo. NOTE: On the Mac it 
is also Control+Z. As a Premiere panel we can’t use Command+Z as a normal application 
would. To Mac OS, Premiere is the active application, so Command+Z undoes Premiere 
functions which doesn’t include the Transcriptive panel.

Maximum Length of transcript: 

Both Speech Services support transcripts of any length. However, very long transcripts can 
affect performance.

Complete info about Captions can be found on Page 51 and 60.

Open Captions:

To create open captions in Premiere, we recommend you export the transcript as SRT. You can 
then import that into Premiere if you need to make small adjustments using the Captions panel, 
or if you want to export them baked into your video. You can also use SMPTE or VTT.

Closed Captions: 

To create closed captions in Premiere, you need to export the transcript as either SMPTE-TT, 
SCC, or MCC. You can then import them into Premiere if you need to make small adjustments 
using the Captions panel, or if you want to export them baked into your video. 

Clip Mode Vs. Sequence Mode

There’s not a lot to this. When Transcriptive is in Clip Mode, you’ll see the transcripts for clips 
in the Project Panel or selected in a sequence. When it’s in Sequence Mode, you’ll see the 
transcripts for the active sequence. 
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However, when you’re editing a transcript, it REALLY matters what mode you’re in.

Clip Mode is usually the Master Transcript. When you make edits in Clip Mode, those edits 
get saved to the Clip’s metadata. What you see in Clip Mode is what will get used when 
you drop a clip into a sequence. If you edit the transcript in a sequence, that edit does not 
get saved with the clip permanently unless you Export>Speech Analysis. Export>Speech 
Analysis, when you’re in Sequence Mode, will save the transcript to the Clip’s metadata, thus 
making it permanent.

We do this because you might edit the text in a sequence in a way that you would not want to 
affect the permanent transcript. For example, in sequence I might delete a bunch of lines from 
the transcript but I don’t want them permanently deleted from the Clip’s transcript.

For more info on how we save data in sidecar files, XMP data and the Premiere project, see 
the next section.
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JSON side car files (vs. Speech analysis)

One of the big new things is how transcripts get saved when they come back from the A.I. 
Service and when they get edited. We save the transcript to Speech Analysis XML (as we did 
in TS 1.0) but we also create a JSON file that lives next to your media clip.

This is partially because of the new Clip Mode. Previously, clips had to be in a sequence to 
get a transcript and when the transcript was edited, that got saved with the sequence. With 
Clip Mode, you can transcribe and edit the transcript of a clip by itself, so… where do we 
save it?

XMP Metadata / Speech Analysis: As in TS 1.0, whenever you submit something to be 
transcribed and we get a transcript back, the transcript gets saved in Speech Analysis, which 
is an XMP field that you can find in the Metadata panel. This is where we save a ‘backup’ of 
the transcript. The only way this can get overwritten is if you go to Export>Speech Analysis 
and manually tell Transcriptive to save the transcript in the panel into Speech Analysis. (when 
you finish cleaning up a transcript, we do recommend you do that. That’ll permanently save 
your edits with the clip’s metadata)

JSON Sidecar File: This is what’s new. When you get a transcript back for a clip, we also save 
a JSON file next to your media file. When you make edits to the transcript, those are saved 
into this JSON file. So if you’re moving a piece of footage around or saving a backup, make 
sure the JSON file goes with it. 

This allows you to make edits to a transcript and still revert back to the original in Speech 
Analysis if something goes wrong.

Sequence’s Transcript: Also, if you add a clip to a sequence, there’s a transcript for that 
sequence that’s different than anything saved at the Clip level. Any changes you make to 
the Sequence’s transcript DOES NOT get saved to the Clip’s Sidecar file or Speech Analysis 
(EXCEPT: If you Export>Speech Analysis from the Sequence then any changes you’ve made 
WILL get saved to SA)

We know this is a little confusing, but just think of it as the difference between the Source 
panel and the Timeline panel. When in Clip Mode, it’s like using the Source panel. Everything 
you do there affects ONLY the clip.

Sequence Mode is, well, like using a sequence timeline. You can cut the clip, apply effects, 
etc. and none of that affects the actual media file. In this case, the transcript only relates 
to that sequence. Changes you make to the sequence transcript are only stored with the 
sequence.

Uh… What did you just say?
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The most important transcript is in the sidecar file next to the media file (e.g. MyMovie.mp4, 
MyMovie_transcript.json). When you make edits in Clip Mode, they get saved here. The 
sidecar file saves not only text but formatting as well. If you move the media, make sure the 
sidecar goes with it. Export>Speech Analysis if you want to save it into the Clip’s metadata 
which will usually save it to the MyMovie.mp4 file. However, this won’t retain formatting, just 
the text.

Sequence Mode: Editing a transcript for a sequence doesn’t affect the sidecar file. So it won’t 
permanently change the Clip’s transcript.  

Editing Text

The Transcriptive 2.0 Text Editor now behaves like a word processor. You just place your 
cursor where you want to start typing and... start typing. You can also double click to select 
an entire word. Since every word has timecode, it doesn’t behave _exactly_ like MS Word or 
something. There are differences. So please read the section on the Text Editor. You definitely 
want to understand how to edit the text without losing the timecode associated with each 
word.

This is VERY different from how Transcriptive 1.0 worked. You no longer need to press ‘Enter’ 
to start editing text. ‘Enter’ will now create a new line, just as it does in a regular word 
processor.

As with the previous version, there are a lot of keyboard shortcuts to help you edit faster. 
Some of these have changed from 1.0. Please take a look at the section on Keyboard 
Shortcuts to familiarize yourself with what you can do. See Page XXX for more info

Selecting Video/Audio to Transcribe

Transcribing A Clip

You can now transcribe individual clips. Just select the clip you want to transcribe in the 
Project panel and click Transcribe. (Make sure you’re in Clip Mode)

Transcribing A Sequence

First off, make sure the Clip Mode switch is turned off and you’re in Sequence Mode.

If you’re transcribing a sequence, Transcriptive will transcribe whatever audio is in the active 
sequence you have selected (we’ll cover Batch processing in a moment). So if you’re looking 
at the timeline of MySequence, that will be the audio that gets transcribed. ALL the audio. So 
if you have multiple tracks of audio it’ll send all of it to the Speech Services. 

This is great if you have dialog on a couple tracks. Both tracks will get transcribed. However 
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if you have dialog on one track, music on another track, goats braying on another track, etc., 
etc…. that’s not so great. Mute the music and the goats before transcribing your dialog. You’ll 
get much better results.

In/Out Points 

Transcriptive will honor IN and OUT points when transcribing sequences (but not with clips... 
however, you can set in/out points in Clip Mode. See Editing with Text on page 25). So if 
you want your entire transcript transcribed or just a portion of it, make sure the ‘Sequence 
Length’ matches what you’re expecting. If it says ‘5 minutes’ and your sequence is 30 
minutes, there’s a problem. It might be the IN/OUT points.

Batch Processing

There are multiple ways of batch processing. Let’s discuss.

Ultimately they all do the same thing: process multiple clips and put the entire transcript into 
the Speech Analysis section of Premiere’s Metadata panel for each clip. This means you can 
search the metadata of each clip in the Source window to find any text in the clip you are 
looking for. If you drop the clip into a sequence, Transcriptive will use the metadata to build 
the transcript, so you don’t incur additional charges from the speech services. It’s very cool if 
you have a bunch of clips you want transcribed.

When you batch process, Adobe Media Encoder gets launched so Premiere doesn’t get tied 
up while all the clips get transcribed. If you have a lot of clips that could take a while and we 
didn’t want Premiere to become unusable while waiting for the transcripts to get back.

Batch Files

This will bring up a dialog letting you select multiple files to be transcribed. This is more or less 
the same as any Open dialog you’ll see.

Batch Folder 

This will bring up a dialog letting you select a folder. Every video/audio file in that folder will 
be transcribed.

Batch Project 

If you have all the files you want transcribed imported into Premiere, create a bin named 
‘Transcriptive’(with a capital “T”). Place all the files you want transcribed into that bin. 
When you select Batch Project, Transcriptive will take all the files in that bin and transcribe 
them. Once that is done, you can move the clips out of the Transcriptive bin. There are some 
Premiere limitations that prevent us from just allowing you to randomly select files in your 
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project. So this was the best workaround we could come up with, but we realize it’s not ideal.

Once you’ve selected your files, you’ll see the Transcribe dialog box. See Page_ for more

Clip Based Workflow : Editing with Text

If you have a clip based workflow, where you drag selects from the Source panel into a 
sequence, this is for you!

It opens up an ‘Editing Video with Text’ workflow. Where you can search for where dialog 
was spoken, select the text and use that to create an edit.

Make sure the Clip Mode button is turned on. (see Clip Mode vs. Sequence Mode below for 
more info on the difference when this is on or off.)

When this is turned on, you can select video or audio files in the Project Panel. If they have 
a transcript that will appear in Transcriptive, if not, you’ll be given the option to Import or 
Transcribe.

When the transcript for the clip appears in the Transcriptive panel, the clip should also appear 
in the Source panel. At this point you can edit and search the transcript as you would expect. 
However, you can also set IN and OUT points (Control + i and Control + o) and INSERT 
(Control + comma) the segment between the IN/OUT points into the active sequence.

This allows you to search the text of the transcript, find the segment you want and then quickly 
insert it into the timeline of your edit. 

Check out our video tutorial on this feature at: https://youtu.be/KVUt2IOR4-c
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Transcriptive User Interface

The user interface is divided into five sections:

1- Top bar with the Menu, Transcribe button, and Status field

2- The main text area for editing the transcription

3- Speaker Identification column showing speakers (this only shows if there speakers were 
identified)

4- Timecode column

5- Bottom bar with the Export options

The Top Navigation Bar

The top bar in the UI has many critical functions. The Main Menu has all the setup dialogs, 
Speaker, Transcript Deletion and Batch Processing dialogs. The lower portion of the bar has 
Undo/Redo buttons, Delete, Split/Merge and punctuation buttons.

Top Nav> Main Menu
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Main>Speech Engine Setup

This dialog is no longer as important as it used to be.

For Transcriptive A.I. and Speechmatics, all you need to do is log into your Transcriptive.com 
account. Nothing else is needed. You can do this in this dialog or under the Account menu.

For Speechmatics, this is only relevent if you’re using their On-Premise solution. You can enter 
in your credential information by going to the Speechmatics tab in Speech Engine Setup. 

On January 1st, 2020 this will stop working with Speechmatics.com accounts.

If you want to set up Speechmatics on your own in-house server, please contact  
sales@digitalanarchy.com for more information on their On-Premise solution.

Main> Speaker Managment

You can add, change or delete the names of the speakers in your transcript using Speaker 
Management. This is useful for when exporting paper transcripts, or grouping your transcript 
by speaker. By default the Speech Services return ‘Speaker 1’, ‘Speaker 2’, ‘Speaker 3’, 
etc. You can also add/delete speakers here as well. Speaker Identification is probably the 
weakest part of the A.I. services, so expect to use this dialog a lot.

Change Only One Speaker Line checkbox

With this selected, when you change a speaker in the main UI, it only changes that one line 
or transcript.

If this is NOT selected, then multiple lines will be changed. All lines below the one you 
change will also change until Transcriptive encounters a line with a different speaker. This can 
be convenient if there’s a lot of dialog and one or the other person speaking for a significant 
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time. It works like this:

Original        Changed 
1: Speaker 1  On Line 2, the A.I. gets it wrong.  1: Speaker 1 
2: Speaker 1  -------- Change to Speaker 2 ----->  2: Speaker 2 
3: Speaker 1  Speaker 2 is actually speaking and  3: Speaker 2 
4: Speaker 1  continues until Speaker 3 speaks.  4: Speaker 2 
5: Speaker 3  Changing Line 2 will cause 3 & 4 to  5: Speaker 3 
6: Speaker 3  also change and stop at Line 5.  6: Speaker 3 

Main>Deleting Speakers

One interesting use of this is that if you decided you don’t want to worry about 
speakers, you can delete all the names in this and it’ll remove the Speaker column in 
the Transcriptive panel.

Main> Sync Transcript to Sequence Edit

This is sort of shortcut to Import>Speech Analysis and only works when you’re in 
Sequence Mode. This looks at the edits in your timeline and regenerates the transcript 
based on the clip segments that are there.

When you initially create a sequence, you might just drop the entire clips into it and 
then edit it down. So when the transcript is initially created it’ll include the entire 
transcript for all the clips. Once you edit the sequence, deleting parts of the clips you 
don’t want, the original transcript will not represent what’s on the timeline. 

This syncs the transcript to what’s actually on your timeline.

*NOTE: This will overwrite any changes you’ve made to the sequence transcript. 
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When recreating the transcript it does so from scratch. Meaning it’ll pull from the transcripts 
saved in the clip’s metadata. So if you plan to do this, don’t edit the sequence’s transcript. 
Switch to clip mode and edit the clip’s transcript.

Main>Delete Transcript

This simply clears out whatever text  is in the Editing Window. You don’t _need_ to do this. If 
you click the Transcribe button it’ll overwrite whatever is in the Edit Window. However, it can 
be useful to visually see that you’re creating a new transcript. So if you want a blank page 
before getting a transcript, just select New Transcripts.

Main>Delete Speech Analysis

Speech Analysis is where Premiere saves the transcript into a clip’s metadata. Transcriptive 
is very good about keeping transcripts saved in a clip’s metadata. USUALLY people do 
not want to lose the transcript and have to pay for transcribing something they already 
transcribed.

However, there may be times when you want to wipe out the transcript completely. You might 
need to send the movie file to someone and not want the transcript included. In that case 
you’d want to delete anything stored in Speech Analysis metadata. This option will do that.

Main> Upgrade Project

This is primarily for Transcriptive 1.2 and earlier users. With version 1.5 we made some 
significant changes to the way we store data. So if you have a very old project, you may 
need to run Upgrade Project to convert those projects to the new format.

If you started using Transcriptive with 1.5 or 2.0, you can ignore this.

Main> Batch Processing

There are multiple ways of batch processing. Let’s discuss.

Ultimately they all do the same thing: process multiple clips and put the entire transcript into 
the Speech Analysis section of Premiere’s Metadata panel for each clip. This means you can 
search the metadata of each clip in the Source window to find any text in the clip you are 
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looking for. If you drop the clip into a sequence, Transcriptive will use the metadata to build 
the transcript, so you don’t incur additional charges from the speech services. It’s very cool if 
you have a bunch of clips you want transcribed.

When you batch process, Adobe Media Encoder gets launched so Premiere doesn’t get tied 
up while all the clips get transcribed. If you have a lot of clips that could take a while and we 
didn’t want Premiere to become unusable while waiting for the transcripts to get back.

Batch Files

This will bring up a dialog letting you select multiple files to be transcribed. This is more or less 
the same as any Open dialog you’ll see.

Batch Folder 

This will bring up a dialog letting you select a folder. Every video/audio file in that folder will 
be transcribed.

Batch Project 

If you have all the files you want transcribed imported into Premiere, create a bin named 
‘Transcriptive’. Place all the files you want transcribed into that bin. When you select Batch 
Project, Transcriptive will take all the files in that bin and transcribe them. Once that is done, 
you can move the clips out of the Transcriptive bin.

Once you’ve selected your files, you’ll see the Transcribe dialog. See below for more details 
on that.

Main> Preferences and Jobs

These can be accessed by icons on the top navigation bar, so they are discussed in a few 
pages.
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Main> Help

The Help section will provide you with links to Keyboard Shortcuts, Video Tutorials, FAQ, this 
Manual, and all around general Tips and Tricks. You can always reach us at  
cs@digitalanarchy.com or 1-415-287-6069

Main> About

Last but not least the Main Menu contains the About section. Here the only lots of information 
about the version of Transcriptive you’re running, whether it’s up to date or not, and of course 
our support cats and Callie The Pitmix who’s our Director of IT.

Top Nav> Import Button

This is a pretty important dialog and lets you get transcripts into Premiere in a number of 
ways. Use the Import Transcript dialgue to import a variety of file types as well as retrieving 
transcripts from Speechmatics, Transcriptive-A.I. and Speech Analysis. 

 
The Import dialogs for Plain Text, SRT, and Transcriptive

Some of the common fields in the Import dialogs:

Character Encoding: Text files are encoded in certain ways depending on the text in them. 
For example, Asian languages need 16-bit text files vs. 8-bit usually required for Western 
languages. If you leave this set to ‘Auto-Detect’ it should work fine. If not, you can manually 
select the encoding.

Timing Per Word: If this is selected, Transcriptive will attempt to give every word timecode. 
It greatly helps if the file has timestamps. We interpolate between timestamps (i.e. make 
educated guesses) to get timecode for the words. So if some says ‘The quick brown fox’ 
between the 10 second mark and the 14 second mark, it’ll go something like this:
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10:00: The 
11:00: quick 
12:00: brown 
13:00: fox 
 
The time range (4 seconds) is divided by the number of words and each word is then 
assigned a timecode. This means if you have VERY frequent timestamps, like an SRT, the 
guesses can be pretty accurate. As you can imagine, if there are no timestamps then the 
guesses are likely to be wildly off.

With SRTs and other subtitle/caption formats we know there will be timestamps. With Plain 
Text files we don’t know for sure, so there are other options which will allow you to give us 
some guidance as to the format of the timestamps and if they’re there at all. Usually we can 
auto-detect it but sometimes you need to tell us what to expect.

Ignore Speakers: If the text file has speakers listed, you can choose to ignore them and 
ONLY bring in the dialog.

Speakers Field: This will show you which speakers we have identified. You can tell us to 
ignore one or all of them.

Starting Timecode: You can let us know what the starting timecode should be for the file. 
This assumes that the text file starts at 15:10:00 and you want to tell us the video clip starts at 
15:00:00.

Set Start Time: This assumes that the timecode in the text file is different than the Starting 
Timecode you entered above (perhaps the file starts at 00:00:00). In which case 
Transcriptive will ignore the start time in the file and conform all the timecode to what you 
want it to start with.

Import> Plain Text 

This imports any plain text file into the Transcriptive window. The text will usually come in 
without timecode, so it’s going to be of limited use unless you use Alignment to sync up the 
text and audio. However, if the text file has timestamps and you turn on ‘Timecode per word’, 
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Transcriptive will attempt to give each word timecode.

Other than the words next to the timestamps this is pretty inaccurate as it interpolates between 
the timestamps and guesses. Although, if you have _very_ frequent timestamps, as you do 
with SRT files, it can be reasonably accurate.

Existing Text File as A Transcript 

If you already have a transcript for a video file and want to sync that up to the audio of the 
video, you can use the Plain Text importer to do that. Import the plain text file and then click 
on Transcribe. Select Alignment from the ‘Transcribe With’ dropdown. This will sync up the 
timecode of the spoken words with the plain text file. See the section on Alignment for more 
info.

Import> SRT (Frequently better than plain text for Timing Per Word)

If you have an existing transcript as a SRT file, you can use the SRT Importer to get that into 
Transcriptive. Since SRTs only have timecode for whole lines, the individual words do not have 
timecode, unless you have Timing Per Word turned on. You can still search and jump to where 
a sentence was spoken, but you can’t do so for individual words. 

However, when Timing Per Word is on, Transcriptive will use the very frequent SRT 
timestamps. It’s a great way of adding timecode per word to text that doesn’t have it.

If you want to import captions from YouTube or Facebook, use SRT. Here are instructions on 
how to do so: https://digitalanarchy.com/blog/art-technology/downloading-the-captions-
facebook-or-youtube-creates/

One huge advantage of SRT is that the timestamps are very frequent. Usually every few 
seconds. This means Timing Per Word is usually very accurate. 

Combine Lines into Paragraphs: Subtitle lines tend to be short, often just 32 characters. 
You have the option of combining these lines into sentences or paragraphs. If the text has 
periods, you can select ‘Split Lines Based on Punctuation’ and a sentence will be formed 
every time there’s a period. If there isn’t any punctuation then it’ll just create a large 
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paragraphs of text.

Import> JSON 

Usually, you don’t need to worry about this. However, JSON is the format of the text file 
Transcriptive uses internally to save transcript data. You can import them directly although 
usually Transcriptive will just read them. But if the file gets moved or something you might 
need to import it manually. JSON files are 1) the format Transcript saves the sidecar file in 
(MyMovie_transcript.json) and 2) created by the Speech Services when they generate the 
transcript. This is what Transcriptive gets when you request a transcript. It’s also what gets 
imported when you go to the Jobs section and click Import.

This also lets you get the transcript on one machine and move it to another. So if your 
facility only has a couple machines connected to the internet, you can use them to get the 
transcription, grab the JSON file and move it to the machine without an internet connection. 
Usually this is stored next to your media file (e.g. MyMovie.mp4 and MyMovie_transcript.
json)

Import> Speech Analysis

Importing Speech Analysis will populate your Transcript Window with any transcript that’s in 
the metadata of your clip (Clip Mode) or all clips that are in your active sequence (Sequence 
Mode). This is used to create a new transcript that reflects edits you’ve made to your timeline.

This pulls data from two places: First, a clip’s JSON sidecar file and secondly, if there’s no 
sidecar file, the Speech Analysis section of the Metadata panel. (See the JSON Sidecar vs. 
Speech Analysis section for more info on how this all works)

You can view the transcript that’s in Speech Analysis by opening the Metadata panel in 
Premiere. Towards the bottom you’ll see the Speech Analysis section. If the selected clip has a 
transcript in the metadata you’ll see a block of text there.

Top Nav> Transcribe Button

The heart of transcriptive is the Transcribe button. This is where the magic begins.

Once you’ve selected the sequence you want to transcribe and muted any non-dialog audio 
tracks, you’ll press the TRANSCRIBE button.

This will bring up the Transcribe dialog box. 
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Transcribe Dialog Box

Before Transcriptive sends the audio file off to the Speech Services we need to tell you a few 
things and we need to know a few things.

Most importantly, which Speech Service do you want to use, Transcriptive or Speechmatics? 

Please use Transcriptive if accuracy is critical to you. It’s more accurate than 
Speechmatics across a wider range of audio quality.

So you’ll need to select one or the other. If you have not setup the Speech Services, there’s 
a button that will take you to that dialog box. You can’t use transcriptive without setting up at 
least one Speech Service.

What We Tell You

First off, we tell you how long the audio is that you’re transcribing. You should check this to 
make sure that you’re not transcribing 3 hours of video when all you really want is 15 minutes.

We also tell you the sequence or clip name, so you can verify you’ve got the right item 
selected.

Most importanly, we tell you the cost. If for some reason this doesn’t line up with your 
expectations, STOP and double check everything. If you’re transcribing a 60 minute clip 
(between $4.00-7.00 depending on the service) and it says $1.10 or $20, something is 
wrong. Maybe you set In/Out points and Transcriptive is pulling from that. Maybe there’s 
a bug and we’re using the length of the previous clip you had selected (maybe it’s still 
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accidentally selected).

The price here is a courtesy and is not binding. Once the file is encoded and we know exactly 
what has been submitted, any bugs on our end usually resolve themselves. So if this has 
an unexpectedly low price, once we process the file, you’ll be charged the correct price. If 
the price is wrong in the dialog we will not issue any refunds. We’re very upfront about our 
pricing and expect that you know what the cost should be regardless of any bugs displaying 
the cost.

Of course, any overcharges... if you actually got charged $20 for a 60 minute video, please 
contact us at cs@digitalanarchy.com so we can issue you a refund.

Transcribe> Options

Transcribe With...: This is where you select which speech service you want to use or sync an 
existing transcript with Alignment. Alignment lets you sync a text transcript up with a video’s 
audio. Giving timecode to a transcript that doesn’t have it. See the section on Alignment for 
more info.

Transcriptive-A.I. will usually be the most accurate, especially if you consider punctuation 
which Speechmatics currently doesn’t do. We’re constantly testing an array of speech-to-text 
services and will use whichever is currently best based on the settings you choose. The service 
we use may change based on several factors including whether Speaker Identification is 
turned on or what language you choose. This is a pay-as-you-go service, so you just pay for 
the minutes as you use them. So it’s a pretty easy option.

Speechmatics will also give you very good results, particularly on clean audio. It doesn’t do 
punctuation other than periods. It’s less expensive than the Transcriptive option. If you have 
a lot of background noise or accents, Transcriptive-A.I. is probably your best bet. It’s almost 
always going to be the most accurate with that type of audio. Speechmatics is great for clean 
audio but the accuracy falls off more steeply as the audio quality gets worse.

Of course, we strongly suggest you run a few tests on your own video footage with 
varying audio quality to see the results yourself. 

Languages: 

We support 24 languages currently. This does not mean we support all of them well. For the 
more common languages: English, Spanish, French, Japanese you should expect a very high 
accuracy rate. For less common languages: Catalan, Hungarian, etc. the results may not 



46 © 2021, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: User Interface

be acceptable. Please run some tests before doing a large transcription project. Select the 
language of your video and away you go. Neither service supports multiple languages in a 
single video.

Speaker Identification

Next, select if you want Speaker Identification and tell us how many speakers there are. 
See the Speaker Identification section for more details on this. Neither speech service does 
a great job of identifying speakers. It’s better than nothing, and the Transcriptive service 
performs better, but it definitely requires clean up. 

Align Current Text checkbox (Paid Alignment)

If you’re getting a new transcript from one of the speech services, make sure this is turned 
off. See the section on Importing An Existing Transcript. This allows you to take an existing 
transcript and sync it to the audio, adding timecode to the existing text. Incredibly useful if you 
already have a transcript from a human transcription service. You MUST import an existing 
text file for this to work. Also, this will incur a cost. If you want to use the free alignment, you 
must choose ‘Alignment’ from the ‘Transcribe With’ dropdown.

When you click OK and Transcriptive exports the audio and sends it to the Speech Services.

Transcriptive-A.I. is $0.02/minute for this service and Speechmatics is $0.04/min. Both 
will produce similar quality results.
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Remember: If you use ‘Transcribe With: Alignment’, you can do this for FREE. (English only 
though)

Top Nav> Auto-Load Toggle

If the Auto-Load button is OFF, it will lock the Transcriptive window to the transcript for a 
particular sequence or clip. Regardless of what the Active Sequence/Clip is, the transcript 
doesn’t change.

If it’s turned ON, then every time you switch to a different sequence or clip, the transcript for 
that sequence/clip is loaded.

This is useful if you’re switching between sequences to find clips or other info but you’re only 
working on one transcript. If this is not turned Off, as you switch sequences Transcriptive will 
load the transcript for that sequence. Usually this is great. However, if you’re only working 
on one transcript, constantly having Transcriptive load a different transcript can be annoying. 
Auto-Load solves that problem.

To use it, go to the sequence/clip you want to always see the transcript for. With that 
sequence/clip selected, turn Auto-Load to OFF. Now whenever you switch to a different 
sequence, you’ll only see the original, locked transcript.

Top Nav> Clip Mode Toggle

Clip Mode is probably the most requested feature. It allows you to edit the transcript of 
individual clips. You no longer have to drop them into a sequence to transcribe or edit the 
transcripts!

In fact, Clip Mode is now where the ‘Master’ transcript for any clip lives. 

What does ‘Master Transcript’ mean? 

The edits you make to the transcript in Clip Mode will get saved to clip’s metadata and 
become permanent. If you drag a clip into a sequence, the sequence transcript will be 
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built using the Master Transcript created in Clip Mode. HOWEVER... The edits you make 
to Sequence’s transcript do NOT change what you see in Clip Mode and aren’t stored 
permanently. Those edits won’t appear in the metadata or other sequences you drop the clip 
into. More about this  below in Clip Vs. Sequences and JSON Sidecar sections.

Clip Based Workflow : Editing with Text

If you have a clip based workflow, where you drag selects from the Source panel into a 
sequence, this is for you!

It opens up an ‘Editing Video with Text’ workflow. Where you can search for where dialog 
was spoken, select the text and use that to create an edit.

Make sure the Clip Mode button is turned on. (see Clip Mode vs. Sequence Mode below for 
more info on the difference when this is on or off.)

When this is turned on, you can select video or audio files in the Project Panel. If they have 
a transcript that will appear in Transcriptive, if not, you’ll be given the option to Import or 
Transcribe.

When the transcript for the clip appears in the Transcriptive panel, the clip should also appear 
in the Source panel. At this point you can edit and search the transcript as you would expect. 
However, you can also set IN and OUT points (Control + i and Control + o) and INSERT 
(Control + comma) the segment between the IN/OUT points into the active sequence.

This allows you to search the text of the transcript, find the segment you want and then quickly 
insert it into the timeline of your edit. 
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Check out our video tutorial on this feature at: https://youtu.be/KVUt2IOR4-c

Top Nav> Sharing Menu [t]
This allows you to share the sequence or clip (and transcript) with your Transcriptive.com. You 
can edit the transcript in a browser. Very useful if you’re going to be away from your main 
computer with Premiere on it and you want to edit the transcripts.

Currently this is in beta. Ultimately you’ll be able to share with other Transcriptive.com users. 
However, for the moment, you can only upload to your own account.

To share the sequence or clip, click on the [t] icon and select Create New.

This will open a dialog that will let you name it or associate a billing code with the web 
project.

You can then either upload a thumbnail of the video file, the transcript or both.

Go to Transcriptive.com, log in and you’ll see the new web project with the video and 
transcript (assuming you uploaded both of them).

 

Top Nav> Jobs Menu     

If there’s an internet failure of some sort and you don’t receive the transcript OR you just want 
to reload the transcript, this makes it even easier to grab the JSON file. This shows a list of 
all the jobs you’ve submitted to Transcriptive. You can select the one you want to use for the 
sequence you’ve selected. (If you have ‘Delete Transcription Jobs’ set in the Preferences, the 
jobs will not be stored and nothing will show up here)



50 © 2021, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: User Interface

 

Just click on the Cloud icon to import the transcript from that job. That will load the transcript 
into the Transcriptive panel.

Top Nav> Preferences Button  

This will show the various preferences that you can set in Transcriptive. 

Speech Service Settings

As stated before, Speechmatics/Transcriptive will hold any job of yours for up to 30 days 
on the server before deleting it. You also have the abilitly to control whether you want the 
services to save your trnascripts at all. If you feel safer not having your transcript saved on 
the server, simply check the ‘Delete transcription jobs from server’ box to automatically 
delete your transcript from their server.

You can also turn off Speechmatics email notifications if you like.

Other

Here you can decide whether you want Transcriptive to automatically check for new updates, 
show drop frame timecode, or change the the time between which Transcriptive auto-saves to 
the Premiere project file.

Under “Other” is where you’ll also find all of the file types that Transcriptive can batch 
transcode to FLAC via Media Encoder.

Display

In the display portion you’ll find the ability to show clip name in your timecode column as a 
quick and easy indicator of what clip you’re at in your sequence. 

This is also where you’ll find the option to turn off the on-boarding tutorial that pops up 



51 © 2021, Digital Anarchy : Smart Tools for Creative Minds | Transcriptive

Transcriptive: User Interface

whenever you open the Transcriptive panel.

Proxy Server

In order to return transcripts from the speech services, Transcriptive must have an open 
connection to either Speechmatics or Transcriptive-A.I.. If you’re in an environment that utilises 
a proxy server, you will need be sure to open up a connection.

Here you’ll find two options to work with. “Use System Setting” will search for whichever 
setting your browser uses to connect to your proxy server allowing you to simply use your 
credential as you would for your browser. 

The other option is to use Manual Settings. Here you’d enter the proxy server address along 
with port number to connect Transcriptive.

If this is all foreign information to you, but you know you’re in a proxy server environment, 
have your I.T. person help you out. They’ll know what to do.

Whitelisting for Firewalls

Here are a list of URLs you may need to whitelist for Transcriptve to work:

digitalanarchy.com 
app.transcriptive.com 
api.speechmatics.com              TCP 443  

Top Nav> Notifications Menu (Transcription Status) 

The Bell icon in the upper, right corner will tell you the status of your transcription, if it 
succeeds or fails and other important messages

The messages you most commonly will see are:
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Encoding FLAC file: This means we’re exporting the audio as a lossless FLAC file, which is 
what the Speech Services require.

Waiting for Transcriptive-A.I.: Once the audio file is sent, we wait for the Speech Services to 
respond either with the transcription text file or an error message. Usually this will take about 
1/4th to 1/2 the time of the audio file. So if you send a 10 minute audio clip, expect it to be 
done in 2-5 minutes.

Transcription Successful: Transcriptive has received the text file and you should see the 
transcription in the Transcriptive panel.

Transcription Failed: This can happen for a number of reasons, including the service being 
down. We try to provide helpful error messages but the Speech Services aren’t always helpful 
in this regard, so sometimes we don’t know why it failed.

Top Nav> Account Menu

This shows you your options for Transcriptive.com and the Transcriptive Speech Services. You 
need to create an account on Transcriptive.com in order to use the Transcriptive-A.I. as that’s 
where we manage billing.

It allows you to create an account, login, and logout. You can also view the jobs you’ve 
submitted, your dashboard, and account settings.
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Account> Login/Register

If you’re not logged in, you’ll see a Login link and a Register link. Use Login to access your 
Transcriptive.com account and Transcriptive-A.I. service. If you don’t have an account, you 
can create a free one by clicking on Register. 

You don’t have to do this to use the Transcriptive panel. If you only want to use Speechmatics, 
you don’t need to create an account on Transcriptive.com. The panel will be fully functional.

However, by creating an account, you can use the Transcriptive Speech Services and you 
can send and receive transcripts from producers or clients using the browser version of 
Transcriptive. Please see Page _ for more info on working with Transcriptive.com

Account> Jobs

This is the same as going to Main Menu>Job Management. It allows you to see all of the 
transcription jobs you’ve placed and reload them if necessary.

Account> My Dashboard

This will take you to your Transcriptive.com dashboard, where you can see how much you’ve 
spent, all your jobs and the costs they incurred, change Billing info and other information 
about your account.

Account> Account Settings

Use this to edit basic account settings like Name and Password. If you want to change your 
Billing information please use My Dashboard instead as it will allow you to change all the 
settings associated with the account.

Top Nav> Undo/Redo

These buttons allow you to undo or redo the last action. You can also use Control+Z for Undo 
and Control+Shift+Z for Redo. NOTE: On the Mac it is also Control+Z as a panel can’t use 
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Command+Z.

Undo/Redo doesn’t work for everything. You can’t undo merging and splitting sentences, for 
example. Eventually we’d like to have everything undoable, but for now it’s just text changes, 
which should over most peoples needs.

Top Nav> Punctuation Bar

These buttons let you easily add punctuation. Just select the word and hit the button or 
corresponding keyboard shortcut (the punctuation key on the keyboard, for example to add 
quotes, select the word and press the Quote (“) key). This makes it very easy to add basic 
punctuation.

The great thing about this is you don’t have to place the cursor exactly where you want the 
punctuation. With Transcriptive, as you’re playing back the audio, you can stop the highlight 
on the word you want to add quotes to and press the “ key, then press Control+” and you’re 
done! Two keystrokes vs. six keystrokes.

On the far right of the Punctuation bar you have four more buttons. From left to right they are: 
Delete Word. Delete Punctuation, Split Line, and Merge Line. Split/Merge Line makes it easy 
for you to separate speakers from when the Speech Service incorrectly assignes the wrong 
speaker, or you’d like to separate a sentence for captioning spacing.

Transcript Window

As you might guess, this is where your tanscript will visually live as you work with 
Transcriptive. In the Transcript Window you can edit the transcription. It also highlights the text 
as the video plays, allowing you to easily follow the text as you listen to the audio playback.

You can edit with keyboard shortcuts as the video plays or you can go into ‘word processor’ 
mode by pressing Enter and edit as you usually would with a text editor.

We cover all this in more detail in the Text Editing section on Pgs 50-54. Also check out the 
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Keyboard Shortcuts section.

Transcript Window> Speaker Identification Column

If you selected ‘Speaker identification’ when you transcribed, the Speech Services will 
attempt to identify how many speakers you have and which text is attributable to each one. 
Neither Speechmatics or Transcriptive are awesome at this, and this typically needs a fair 
amount of cleanup. Transcriptive-A.I. will usually do a better job however.

The Speaker Column shows which speaker the Speech Service thinks said that particular 
sentence.

You can change the speaker by clicking on the dropdown menu and selecting the correct 
speaker. You have two options for how it behaves when you do this. You can change one line 
at a time OR you can have it change every line below that until it runs into a different speaker. 
You can change that by going to the Speaker Management dialog in the main menu. 
Here’s how the multiple line mode works:

Original        Changed 
1: Speaker 1  On Line 2, the A.I. gets it wrong.  1: Speaker 1 
2: Speaker 1  -------- Change to Speaker 2 ----->  2: Speaker 2 
3: Speaker 1  Speaker 2 is actually speaking and  3: Speaker 2 
4: Speaker 1  continues until Speaker 3 speaks.  4: Speaker 2 
5: Speaker 3  Changing Line 2 will cause 3 & 4 to  5: Speaker 3 
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6: Speaker 3  also change and stop at Line 5.  6: Speaker 3

By default the column will show Speaker 1, Speaker 2, etc. You can change that to real 
names by going to the Speaker Management dialog in the main menu. You can also add 
speakers there.

Transcript Window> Timecode Column

This shows the start  timecode of any given sentence or block of text. In most cases, each 
word will have timecode associated with it. As you click on each word, the Time Marker in 
Premiere will jump to the portion of the timeline where it’s spoken. The Timecode Column only 
displays the timecode for the first word.

If you split (Opt/Alt+Down Arrow) a sentence or block of text, the timecode of the word you 
split on will appear in the Timecode column.

Another piece of information you can find in the Timecode column is when a new clip has 
started in your timeline. If you see the name of a clip in the timeline column, you know that 
every timecode appearing below is in that specific clip until you see the next clip name.

This column is primarily for informational purposes only.  

However... you can now adjust timecode for every word. Just right+click on any word to get 
the Adjust Timecode dialog. If you adjust the first word in a sentence or create a new line with 
a word you’ve adjusted, the Timecode Column will update accordingly.

Bottom Navigation Bar

The lower navigation bar has controls to move around the text, Search toolbar and the Export 
dialog. All critical parts of Transcriptive.

Playback And Cursor Controls

The controls right below the text window allow you to move where the highlight is. Especially 
when you’re using the keyboard shortcuts, it’s fast and easy to highlight any word. The 
controls are:
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 - to the next/previous word (keyboard shortcut: right/left arrow)

 - to the next/prev sentences (keyboard shortcut: Alt/Opt + right/left arrow)

 - to the next/prev speaker (keyboard shortcut: Alt/Opt + Shift + right/left arrow)

 - Play: Starts playback. The video/audio will play while the highlighted word moves   
 along with whatever is spoken. (keyboard shortcut: Spacebar)

 - Playback Speed: Lets you set the playback speed to realtime or 1.5x faster than   
 realtime. This is very useful, especially if the transcript is accurate. You can    
scan for incorrect words much faster. It takes a little getting used to, but once    
you do it’ll speed up your cleanup.

Sync to Playhead (recycle icon): This jumps the highlighted word in the Transcriptive panel 
to match where the time marker is in your sequence or clip. If you move the Time Marker, 
Transcriptive doesn’t know about it, as Premiere’s timeline doesn’t notify Transcriptive about 
the change. If you click on this icon, this will sync the highlighted word to where the Time 
Marker is. 

Export

There’s a lot going on in this little dialog. You can export the entire transcript to a closed 
caption file, export it to Premiere’s metadata or markers, or export a plain text file for paper 
edits.
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Export> Plain Text/Rich Text Format

Exporting paper trancripts can be done easily with Transcriptive. You have the option of 
both Plain Text (.txt) and Rich Text Format (.rtf) file types. RTF has more formatting options 
than Plain Text, and is recommended when exporting transcripts meant to be looked at by a 
human. Plain text works better if you’re going to be importing the file into another system. A 
Caption Editor for example. Both file types can be opened in various word processors.
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Export> JSON

These files are mostly for moving the transcript to a different machine with Transcriptive or 
backing up the edited transcript. You can just move the entire Premiere project to the other 
machine. However if you just want to get the transcription over to the other machine, you can 
export out as JSON file and import it on the other end. See pg 22 for more information on 
moving transcript and project files. 

While these are technically text files, there’s no standard JSON format, so it’s unlikely other 
applications will import the JSON saved from Transcriptive.

Export> Sequence Markers

This exports the transcript to sequence markers. You can then search the text via the Markers 
panel. This can be very useful if you want to close the Transcriptive panel or if you need 
to send the project to someone that doesn’t own Transcriptive. The entire transcript will be 
embedded into sequence markers which will show up in both the timeline and Program 
window.
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When you export you get three options:

Set Duration: The Markers will have a start and end time. Regular markers can be hard to 
grab, but with this set, the marker will stretch over the time the words are spoken. The larger 
markers also make it easier to hover over to see the text that’s in them.

Include Speakers: This will include the speaker names in the text of the markers.

Seconds Between Markers: This sets the frequency of the markers. If you set this to 10 
seconds, a marker will be laid down about every 10 seconds. Each marker will include 
the text that STARTED being spoken in the10 seconds after the marker (to use the above 
example). So if you have a sentence that starts at 10:05, another one at 17:15 and a third at 
19:20, those three sentences will be included in the marker at 10:00.

But, you know... it’s complicated.

If the sentence that starts at 19:20 is long and the next sentence is at 31:10, no marker will be 
laid down at 20:00 as no sentence starts between 20:00 and 30:00. The next marker will be 
at 30:00.

Export> Clip Markers

Clip Markers can be an awesome way of moving the transcript around. Clip Markers are 
embedded into the video file, so if you import the clip into a different project or move it to a 
different machine, the clip markers (and the transcript) will go with it.

You’ll see these show up ON the clip itself in the timeline. Sequence markers show above the 
timeline.

The options are the same as Sequence Markers (see previous poge) and work the 
same way.
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Export> Speech Analysis

Exporting to Speech Analysis overwrites the metadata of the clips in your timeline. This will 
save the data to the clip’s sidecar file as well as the XMP Speech Analysis field. (see JSON 
Sidecars vs Speech Analysis section) 

When you first transcribe a clip, the original un-edited version gets saved in the Speech 
Analysis field. Export>Speech Analysis assumes you want to overwrite this with an updated/
edited version of the transcript. So be careful!

If you highlight a clip in your timeline and then switch to your metadata panel you’ll see the 
corresponding transcript in the Speech Analsysis field.

Having your transcript baked into your clips metadata allows for Transcriptive to conform 
new transcripts based off your sequence edits.

This behaves a little differently in Clip and Sequence Mode. In Clip Mode Transcriptive is 
always saving to the JSON sidecar file. That’s the ‘Master Transcript’. The original un-edited 
transcript gets saved to Speech Analysis XMP data when you get first transcribe the clip. The 
only way to update Speech Analysis in Clip Mode is to Export>SA.

We don’t generally recommend using this in Sequence Mode. It saves any changes you’ve 
made to a transcript to the relevent clips Sidecar file and Speech Analysis. However, it’s 
possible to lose data if you’ve deleted lines in the Sequence transcript. We recommend you 
edit the transcripts in Clip Mode. 

Export> Closed Captions & Subtitles

Transcriptive can export a variety of closed caption and subtitle files. Each file type has 
different restrictions, but overall they do basicaly the same thing. Be sure to inquire about your 
final delievery to properly choose which caption file is best suited for you.

In Transcriptive when you export a caption file you’ll be presented with a dialogue box with 
options pertaining to your specific file type.

Character Encoding: This allows you to choose which encoding your text will show as. It’s 
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Troubleshooting section 

How to Get The Best Results from Transcriptive

Speechmatics will give you the most accurate transcription. So if you’re doing captions and subtitles 
and will be cleaning up the text, Speechmatics will save you a lot of time.

If you’re just using the transcript to allow you to search your video, Watson is still quite accurate and 
a lot less expensive. For search, it’s a good, economical solution especially if you have a lot of video 
footage. 

Recording Your Audio

The higher the quality of your audio, the better the accuracy of the transcript. If someone is well mic’d 
in a sound proof room, you’re going to get better results than if you’re using the microphone on your 
iPhone on a busy, New York street corner.

The speech services do an amazing job but they can’t overcome garbage audio. Garbage in, 
garbage out.

This doesn’t mean it has to be perfect.

In fact, it’s rarely perfect and the transcriptions are still usually excellent (especially from 
Speechmatics). However, the closer you follow the below guidelines, the better chance you have of 
getting a highly accurate transcript. 

The Microphone

A good microphone goes a long way. So if you have your talent speaking into a good mic, even if 
you’re on a street corner (maybe not the busiest New York street corner ever, let’s not push it), the 
transcript should still come out excellent.

Our favorite microphone is the Behringer Ultravoice Xm8500 Dynamic Cardioid Vocal Microphone. 
You can get it for $20 and it’s great. Omni-directional mics pick up more noise. They can be great, the 
Sennheiser ME2 lav mic we have is awesome, but good ones are more expensive and, regardless, 
they pick up more noise.  

Background Noise

The less background noise the better. The quieter you can get the space you’re recording in to be, the 
better off you’ll be. However, all background noise is not created equal. White noise (waves crashing, 
cars passing) is less problematic than being in a room with lots of people talking.  
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Noise Reduction

Do NOT use noise reduction software on your audio. It will make the transcription worse. The AIs are trained with normal 
recordings, so the noise reduction software distorts what they’re expecting and the resulting speech-to-text is worse. (Machine 
learning works by giving an AI test data that it can learn with. It will do a better job with files that are similar to the files it 
learned on. So if it’s been trained with recordings with normal noise, it’ll do less well on recordings that have been manipulated 
to not have noise.) 

Talent That Can Enunciate

The speech services can handle accents. It’s really not a problem if you have a British, Indian or American accent.

Enunciation on the other hand... that matters. If you’re interviewing a drunk southern boy, the transcription will probably fare 
worse than your interview of that English barrister.

Try to get your talent to speak as clearly as possible. Again, it doesn’t have to be perfect. If they speak a bit fast or use a little 
slang, it should still result in a good transcription. But the further away you get from clear, well enunciated language, the worse 
the transcription is going to be.
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